VISUALDSP® 5
Licensing Guide
(including the ADSP-BFxxx, ADSP-21xxx, ADSP-TSxxx)

Revision 1.4, September 2013
Part Number
82-002035-01

Analog Devices, Inc.
One Technology Way
Norwood, Mass. 02062-9106
Copyright Information

©2013 Analog Devices, Inc., ALL RIGHTS RESERVED. This document may not be reproduced in any form without prior, express written consent from Analog Devices, Inc.

Printed in the USA.

Disclaimer

Analog Devices, Inc. reserves the right to change this product without prior notice. Information furnished by Analog Devices is believed to be accurate and reliable. However, no responsibility is assumed by Analog Devices for its use; nor for any infringement of patents or other rights of third parties which may result from its use. No license is granted by implication or otherwise under the patent rights of Analog Devices, Inc.

Trademark and Service Mark Notice

The Analog Devices logo, Blackfin, EngineerZone, EZ-Board, EZ-KIT Lite, SHARC, and VisualDSP++ are registered trademarks of Analog Devices, Inc.

All other brand and product names are trademarks or service marks of their respective owners.
CONTENTS

PREFACE

Purpose of This Manual ................................................................. ix
Intended Audience ...................................................................... ix
Manual Contents ......................................................................... x
What’s New in This Manual ......................................................... xi
Technical Support ...................................................................... xi
Supported Processors ............................................................... xii
Product Information ..................................................................... xii
  Analog Devices Web Site .......................................................... xiii
  EngineerZone .......................................................................... xiii
Notation Conventions .................................................................. xiv

LICENSING OVERVIEW

Supported Platforms .................................................................... 1-2
System Requirements ................................................................... 1-3
Using this Book .......................................................................... 1-3
  Further Reading ......................................................................... 1-4
Upgrading to VisualDSP++ 5 from Earlier Versions .................... 1-5
Licensing Options ........................................................................ 1-6
Node-Locked Licenses ............................................................. 1-7
  Full Licenses ..................................................................... 1-7
  Evaluation Licenses .......................................................... 1-8
  Test Drive Licenses ........................................................... 1-8
Floating (Client-Server) Licenses ............................................. 1-9
  Single-Seat vs. 5-Seat Floating Licenses ............................... 1-9
Obtaining a License Serial Number ........................................... 1-10
  Full Licenses and Evaluation Licenses ................................. 1-10
  Test Drive Licenses ........................................................... 1-10
Locating License Serial Numbers
  Already Installed in VisualDSP++ ....................................... 1-11

INSTALLING A NODE-LOCKED LICENSE

  Opening the About Dialog Box .............................................. 2-1
  Entering Your Serial Number ............................................... 2-3

INSTALLING A FLOATING LICENSE SERVER

  Server Machine .................................................................... 3-2
    Task 1A: Disabling and Uninstalling an Existing Floating License Server ........................................... 3-3
    Task 1B: Installing the VisualDSP++ Floating License Server ............................................................. 3-4
    Task 2: Installing a Server License ................................. 3-6
    Task 3: Configuring and Starting FLEXnet LMTOOLS .......... 3-9
  Client Machine .................................................................. 3-13
    Task 4: Installing a Client License .................................... 3-13
    License Borrowing .......................................................... 3-16
Further Reading ................................................................. 3-17

REGISTERING AND VALIDATING YOUR LICENSE

Required Information ......................................................... 4-2
  License Serial Number ................................................... 4-2
  Host ID ........................................................................... 4-2
    Finding the Host ID for a Node-Locked License ............ 4-3
    Finding the Host ID for a Floating License .................... 4-3
Registering Your License .................................................. 4-4
  Registering a Node-Locked License ............................... 4-5
  Registering a Floating License ....................................... 4-5
Validating Your License .................................................... 4-7
  Validating a Node-Locked License ................................. 4-8
  Validating a Floating License ........................................ 4-9

CHECKING THE STATUS OF YOUR LICENSE

Viewing a License’s Status .................................................. 5-1
Node-Locked Licenses ....................................................... 5-2
  Full Licenses ............................................................... 5-3
  Evaluation Licenses ...................................................... 5-3
  Test Drive Licenses ...................................................... 5-4
Client Licenses ............................................................... 5-5

TROUBLESHOOTING

Frequently Asked Questions (FAQs) ................................. 6-2
  General FAQs ............................................................. 6-2
Thank you for purchasing Analog Devices, Inc. development software for digital signal processing (DSP) applications.

**Purpose of This Manual**

The *VisualDSP++ 5 Licensing Guide* describes how to manage your license for VisualDSP++ software. For users who purchase floating licenses, this guide also describes the Floating License Server.

This manual does not describe licensing versions of VisualDSP++ prior to release 5. For information about older versions, contact Licensing Support.

**Intended Audience**

The primary audience of this book is anyone who works with VisualDSP++®, a licensed product from Analog Devices. It describes the product licensing options, installation, and activation. The guide also includes the troubleshooting and FAQ sections for licensing issues.
Manual Contents

The manual contains:

- Chapter 1, “Licensing Overview”
  Describes the available VisualDSP++ license types and licensing options.

- Chapter 2, “Installing a Node-Locked License”
  Details how to install a node-locked license.

- Chapter 3, “Installing a Floating License Server”
  Details how to install floating licenses and set up the license server.

- Chapter 4, “Registering and Validating Your License”
  Details the process of registering and validating your license in order to make it permanent.

- Chapter 5, “Checking the Status of Your License”
  Describes the status (as shown in the About dialog box) for each VisualDSP++ license type.

- Chapter 6, “Troubleshooting”
  Explains commonly encountered error messages and provides answers to frequently asked questions.

- Appendix A, “Licensing Support”
  Describes how to contact Analog Devices regarding licensing issues.
What’s New in This Manual

This revision of the VisualDSP++ Licensing Guide includes modifications and corrections based on the latest revision of VisualDSP++.

Refer to VisualDSP++ 5.1 Release Notes for information about new and updated features.

Technical Support

You can reach Analog Devices processors and DSP technical support in the following ways:

- Post your questions in the processors and DSP support community at EngineerZone®:
  http://ez.analog.com/community/dsp

- Submit your questions to technical support directly at
  http://www.analog.com/support

- E-mail your questions about processors, DSPs, and tools development software from CrossCore Embedded Studio or VisualDSP++:

  Choose Help -> Email Support. This creates an e-mail to
  processor.tools.support@analog.com and automatically attaches
  your VisualDSP++ version information and license.dat file.

- E-mail your questions about processors and processor applications to:
  processor.support@analog.com or
  processor.china@analog.com (Greater China support)

- In the USA only, call 1-800-ANALOGD (1-800-262-5643)
Supported Processors

- Contact your Analog Devices sales office or authorized distributor. Locate one at: www.analog.com/adi-sales
- Send questions by mail to: Processors and DSP Technical Support, Analog Devices, Inc., Three Technology Way, P.O. Box 9106, Norwood, MA 02062-9106, USA
- For licensing support, contact Licensing Support.

Supported Processors

This manual documents support for the following Analog Devices, Inc. processors:

- Blackfin® (ADSP-BFxxx)
- SHARC® (ADSP-21xxx)
- TigerSHARC® (ADSP-TSxxx)

The majority of the information in this manual applies to all processors. For a complete list of processors supported by VisualDSP++ 5, refer to the online Help.

Product Information

Product information can be obtained from the Analog Devices Web site and CrossCore Embedded Studio online help system.
**Analog Devices Web Site**


To access a complete technical library for each processor family, go to http://www.analog.com/processors/technical_library. The manuals selection opens a list of current manuals related to the product as well as a link to the previous revisions of the manuals. When locating your manual title, note a possible errata check mark next to the title that leads to the current correction report against the manual.

Also note, MyAnalog.com is a free feature of the Analog Devices Web site that allows customization of a Web page to display only the latest information about products you are interested in. You can choose to receive weekly e-mail notifications containing updates to the Web pages that meet your interests, including documentation errata against all manuals. MyAnalog.com provides access to books, application notes, data sheets, code examples, and more.

Visit MyAnalog.com to sign up. If you are a registered user, just log on. Your user name is your e-mail address.

**EngineerZone**

EngineerZone is a technical support forum from Analog Devices. It allows you direct access to ADI technical support engineers. You can search FAQs and technical information to get quick answers to your embedded processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar design challenges. You can also use this open forum to share knowledge and collaborate with the ADI support team and your peers. Visit http://ez.analog.com to sign up.
# Notation Conventions

Text conventions in this manual are identified and described as follows.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File -&gt; Close</strong></td>
<td>Titles in bold style indicate the location of an item within the VisualDSP++ environment’s menu system (for example, the Close command appears on the File menu).</td>
</tr>
<tr>
<td>`{this</td>
<td>that}`</td>
</tr>
<tr>
<td>`[this</td>
<td>that]`</td>
</tr>
<tr>
<td><code>[this,...]</code></td>
<td>Optional item lists in syntax descriptions appear within brackets delimited by commas and terminated with an ellipse; read the example as an optional comma-separated list of this.</td>
</tr>
<tr>
<td><code>.SECTION</code></td>
<td>Commands, directives, keywords, and feature names are in text with letter gothic font.</td>
</tr>
<tr>
<td><code>filename</code></td>
<td>Non-keyword placeholders appear in text with italic style format.</td>
</tr>
</tbody>
</table>

- **Note:** For correct operation, ...
  - A note provides supplementary information on a related topic. In the online version of this book, the word Note appears instead of this symbol.

- **Caution:** Incorrect device operation may result if ...  
  - Caution: Device damage may result if ...  
  - A Caution identifies conditions or inappropriate usage of the product that could lead to undesirable results or product damage. In the online version of this book, the word Caution appears instead of this symbol.

- **Warning:** Injury to device users may result if ...  
  - A Warning identifies conditions or inappropriate usage of the product that could lead to conditions that are potentially hazardous for devices users. In the online version of this book, the word Warning appears instead of this symbol.
This chapter describes licensing options available for VisualDSP++ 5 users.

The following topics are covered:

- Supported Platforms
- System Requirements
- Using this Book
- Upgrading to VisualDSP++ 5 from Earlier Versions
- Licensing Options
- Obtaining a License Serial Number
Supported Platforms

VisualDSP++ 5 is supported on the following operating systems:

- Windows 2000® SP4
- Windows XP Professional SP3 (32-bit only)
- Windows 7 Professional, Enterprise, or Ultimate (32- and 64-bit)
- Windows® 8 Pro and Enterprise
- Windows Vista™ Business, Enterprise, or Ultimate SP2 (32-bit only)

Windows Vista, Windows 7, and Windows 8 users may experience User Access Control (UAC) related errors if the software is installed into a protected location, such as Program Files or Program Files (x86). We recommend installing the software in a non-UAC-protected location.

If using Windows 7 or later, refer to DOC-1190 on the FAQ page at http://ez.analog.com.


VisualDSP++ License Manager

The VisualDSP++ License Manager is supported on Windows Server 2003 and all operating systems listed in this section.
System Requirements

Verify that your PC has these minimum requirements for the VisualDSP++ 5 installation:

- 1 GHz single-core processor
- 512 MB RAM
- 2 GB available disk space
- One open USB port

A faster disk drive decreases the build time, especially for a large amount of source files.

Using this Book

If you are upgrading to VisualDSP++ 5 from an earlier release, read Upgrading to VisualDSP++ 5 from Earlier Versions.

If you want to use a node-locked license, read:

- Obtaining a License Serial Number for information on obtaining a license if you do not have one yet
- Installing a Node-Locked License for instructions on how to install your node-locked license
- Registering and Validating Your License for instructions on how to register and validate your license
- Checking the Status of Your License for instructions on determining the current status for an installed license
If you want to use a floating license, read:

- **Obtaining a License Serial Number** for information on obtaining a license if you do not have one yet
- **Installing a Floating License Server** for instructions on setting up a floating license server
- **Registering and Validating Your License** for instructions on how to register and validate your license
- **Checking the Status of Your License** for instructions on determining the current status for an installed license

If you have a question about, or a problem with, your license, read **Troubleshooting**, which explains commonly encountered error messages and provides answers to frequently asked questions.

If you require assistance with any licensing issues, refer to **Licensing Support**.

**Further Reading**

For information on FLEXnet licensing, see the *FLEXnet Licensing End User Guide*, which is installed with both VisualDSP++ 5 and Floating License Server software.

In the VisualDSP++ 5 installation, the document is located in the `<install_path>\Docs\Flex` folder.

In the Floating License Server installation, the document is located in the `<install_path>\LMSERVER` folder.

Additional frequently asked questions and information on recently discovered licensing anomalies can be found in the FAQs section of the ADI EngineerZone, at http://ez.analog.com.
Upgrading to VisualDSP++ 5 from Earlier Versions

Starting with revision 5, VisualDSP++ supports FLEXnet license borrowing, to allow use of a MAC address as host ID, and to permit node-locked licenses to work with a Remote Desktop.

These changes have lead to a modification to the format of VisualDSP++ license strings, and therefore validation codes. This means that when you register your serial number and host ID, two validation codes will be e-mailed to you. One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid for VisualDSP++ 5 and later versions. Ensure that you install the appropriate validation code for the version of VisualDSP++ that you are using.

When upgrading to VisualDSP++ 5 from an earlier release of the tools, you can do either of the following:

- During installation of VisualDSP++ 5, choose to copy an existing license.dat file into your VisualDSP++ 5 <install_path>\System folder, or do so manually once VisualDSP++ 5 has been installed. This option will allow you to get up and running immediately, but will mean that the new features mentioned above will not be enabled.

- During installation of VisualDSP++ 5 choose not to copy an existing license.dat file into your VisualDSP++ 5 <install_path>\System folder. Instead, install your serial numbers, then re-register them, and re-validate them. See Registering and Validating Your License for further details. This option will enable the new features mentioned above.

If you do copy an existing license.dat file from an earlier version of VisualDSP++ during installation of VisualDSP++ 5, and later wish to use any of the new features, you must move your license.dat file out of the
way (renaming it to something like license_45.dat so you can identify it later if necessary), and then re-install your serial numbers, re-register them, and re-validate them.

The license.dat files created by VisualDSP++ 5 work with VisualDSP++ 4.5 and VisualDSP++ 4.0. This may be useful if, for any reason, you need to revert to an earlier version of the tools.

Licensing Options

VisualDSP++ licenses are architecture specific; a separate license is required for each of the processor architectures (Blackfin, SHARC, and TigerSHARC) supported by VisualDSP++.

VisualDSP++ licenses are version-independent. Most serial numbers that worked with previous versions of VisualDSP++ also work with VisualDSP++ 5.

Licenses are issued in the form of a unique serial number and typically take the following form:

- **Full License**
  
  ADI-xxx-xxx-xxxxxxxx-xxx

- **Evaluation License**
  
  KIT-xxx-xxx-xxxxxxxx-xxx

- **Test Drive License**
  
  TST-xxx-xxx-xxxxxxxx-xxx

**Note:** “x” represents a digit (0–9).

This section also covers the following topics.

- **Node-Locked Licenses**
- **Floating (Client-Server) Licenses**
Node-Locked Licenses

Occasionally referred to as a *single user license* or a *per user license*, a node-locked license is locked to the host ID of the host computer and provides a single license “seat”. Once installed, VisualDSP++ runs on that one machine only.

You may install and register the software on additional machines for your exclusive use, but each request for registration is handled by Analog Devices on a case-by-case basis.

The three distinct types of available node-locked licenses (*Full Licenses*, *Evaluation Licenses*, and *Test Drive Licenses*) are described next. The debug sessions enabled by each type of license are summarized in Table 1-1.

Table 1-1. Debug Sessions vs. Licenses

<table>
<thead>
<tr>
<th>Debug Session</th>
<th>Full License (ADI serial number)</th>
<th>Evaluation License (KIT serial number)</th>
<th>Test Drive License (TST serial number)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EZ-KIT Lite</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Emulator</td>
<td>Yes</td>
<td>Yes 90 days only Refer to the note below</td>
<td>Yes 90 days only</td>
</tr>
<tr>
<td>Simulator</td>
<td>Yes</td>
<td>Yes 90 days only Refer to the note below</td>
<td>Yes 90 days only</td>
</tr>
</tbody>
</table>

**Note:** The initial 90-day period incorporates all the capabilities of a “full license”. After 90 days (unless you have upgraded the license to a full license), simulator and emulator connections become prohibited and user program size becomes limited.

Full Licenses

Occasionally referred to as an *unrestricted license* or a *permanent license*, a full license (whether node-locked or floating) enables simulator, emulator, and EZ-KIT Lite debug sessions.
Licensing Options

Once installed, a full license must be registered and validated within 30 days; otherwise, VisualDSP++ will become inoperable until it is validated.

**Evaluation Licenses**

Occasionally referred to as an *EZ-KIT license or a demo license*, an evaluation license is a permanent, but restricted license. An EZ-KIT Lite license incorporates an initial 90-day full license. Once the 90 days have passed, the evaluation license becomes restricted, prohibiting simulator debug sessions and emulator debug sessions and restricting the amount of internal memory that is available for code (program memory).

Once installed, an evaluation license must be registered and validated within 10 days; otherwise, VisualDSP++ will become inoperable until it is validated.

![Info icon] Evaluation licenses may be installed only once per machine. Therefore, back up your `<install_path>\System\license.dat` file.

**Test Drive Licenses**

A test drive license is a temporary license, currently issued for 90 days, after which it expires and renders VisualDSP++ inoperable. This type of license enables emulator debug sessions and simulator debug sessions only.

Test drive licenses do not require validation.

![Info icon] Test drive licenses can be installed only once per machine. Therefore, back up your `<install_path>\System\license.dat` file. Also, a test drive license cannot be installed if an evaluation license for the same architecture is already installed (or has ever been installed) on the same machine.
Floating (Client-Server) Licenses

Floating licenses have two parts: a server, and a client. The Floating License Server manages the license pool stored on the server. One serial number is installed on the server for each single seat or 5-seat package. In this model, there can be as many client installations as desired. Each time a user starts VisualDSP++ on a client machine, one license is “checked out” from the server. When the user exits VisualDSP++, the license is returned (checked back in) to the server. As long as there are available licenses on the server, clients can use VisualDSP++.

For example, assume that your license server is configured with 10 licenses, and you have set up 20 client machines in three labs. Any 10 developers may use VisualDSP++ concurrently. When the 11th developer tries to connect, an error is emitted. This type of configuration permits the sharing of software resources in an environment that requires more locations than developers.

As of VisualDSP++ 5, the FLEXnet license borrowing feature is supported. Refer to License Borrowing for details.

Only full licenses are available as floating licenses. Evaluation licenses and test drive licenses are not available as floating licenses.

Single-Seat vs. 5-Seat Floating Licenses

Floating licenses are available in both the “single-seat” or “5-seat” bundle options, where “seat” refers to the number of concurrent licenses that may be checked out while using VisualDSP++. 
Obtaining a License Serial Number

This section contains the following topics:

- Full Licenses and Evaluation Licenses
- Test Drive Licenses
- Locating License Serial Numbers Already Installed in VisualDSP++

Full Licenses and Evaluation Licenses

Full licenses and evaluation licenses may be purchased in the following ways.

You can buy licenses directly from Analog Devices or from a local distributor. Obtain information about Analog Devices sales offices and local distributors in your area from the Analog Devices Web site at http://www.analog.com/salesdir/continent.asp.

Depending on your location, you may also be able buy direct via the Analog Devices Web site’s Buy Online facility at http://www.analog.com/commerce/index.html.

When you purchase your copy of VisualDSP++, you will receive a card bearing your license serial number.

Test Drive Licenses

In order to receive a test drive license, you must register online at www.analog.com/adi-sales.

If you have registered for a Blackfin or SHARC test drive license, a TST serial number will be e-mailed to you when you click the Register button.

Otherwise, the TST serial number will be displayed on the next page, when you click Register.
Locating License Serial Numbers
Already Installed in VisualDSP++

To find a serial number of the licenses already installed in VisualDSP++, do one of the following:

- (Node-locked licenses) Start -> All Programs -> Analog Devices -> VisualDSP++ 5 <version_number> -> Manage Licenses.

- (Floating licenses) Start -> All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager.
Obtaining a License Serial Number
2 INSTALLING A NODE-LOCKED LICENSE

This chapter assumes that you have already installed VisualDSP++ 5 and obtained a license serial number.

If you are upgrading to VisualDSP++ 5 from an earlier version, read Upgrading to VisualDSP++ 5 from Earlier Versions.

The chapter describes:

- Opening the About Dialog Box
- Entering Your Serial Number

This chapter does not cover the installation of the client license part of a floating license. For information about installing client licenses, refer to Installing a Floating License Server.

Opening the About Dialog Box

To install a node-locked license, the serial number must be entered via the Licenses page of the About dialog box (Figure 2-1), which can be accessed in any of the following ways:

From the Windows Start menu, go to All Programs -> Analog Devices -> VisualDSP <version_number> -> Manage Licenses.
Opening the About Dialog Box

• Start VisualDSP++ while pressing and holding down the Ctrl key until the Session Wizard appears. Then click Licenses.

• From within the VisualDSP++ IDDE, choose Help -> About VisualDSP++, and then click the Licenses tab.

Figure 2-1. Licenses Page of the About Dialog Box

Also, when starting VisualDSP++ for the first time, if a license.dat file has not been copied from an existing installation of VisualDSP++ during the installation process, you encounter the following message and are prompted to install a license.

A valid license could not be found. Click Yes to install a license at this time. Click No to close VisualDSP++. 
Entering Your Serial Number

From the Licenses page of the About dialog box, enter your serial number, as follows:

1. Click New.

The Install New License dialog box (Figure 2-2) appears.

![Install New License Dialog Box](image)

2. Select Node-locked license or Test Drive license (default).

3. In Serial number, enter your serial number exactly as it appears, including dashes.

4. Click OK.
The following (or similar) success message appears.

Figure 2-3. Success Message

A license.dat file has now been created in your `<install_path>\System` folder.

If you are using Windows Vista (or later) and have User Account Control enabled, the license.dat file is saved to your Virtual-Store directory:

C:\Users\<user_name>\AppData\Local\VirtualStore\Program Files\Analog Devices\VisualDSP <version_number>\System.


If using Windows 7 or later, refer to DOC-1190 on the FAQ page at http://ez.analog.com.

At this time, your license have been activated for a temporary period only. Your newly installed serial number appear on the Licenses page of the
About dialog box, with the following status, depending on the type of license you have installed:

- ADI-prefixed serial numbers display as Not Validated (Expiring in 30 days)
- KIT-prefixed serial numbers display as Not Validated (Expiring in 10 days)
- TST-prefixed serial numbers display as Test Drive (Expiring in 90 days)

An example appears in Figure 2-4:

Figure 2-4. Serial Number Installed

In order to make your full license or evaluation license permanent, you must validate the license. You obtain the necessary validation code by registering online.

If you do not validate your license during the temporary license period, your license will cease to function until it is validated. Refer to Registering and Validating Your License.
Entering Your Serial Number
3 INSTALLING A FLOATING LICENSE SERVER

There are two parts to floating licenses: server and client. The server manages the license pool stored locally on the server. The clients “check-out” and return licenses to the server as needed, when VisualDSP++ is started and exited.

This chapter describes all the steps required to install floating licenses. First, the Floating License Server (version 2.00.7 or later is compatible with VisualDSP++ 5) and server license(s) are installed on your server machine. Second, VisualDSP++ 5 and your client license(s) are installed on your client machine(s).

This chapter also describes the FLEXnet license borrowing feature, which is new to VisualDSP++ 5.

⚠️ If you are upgrading to VisualDSP++ 5 from an earlier version, read Upgrading to VisualDSP++ 5 from Earlier Versions.

The chapter is organized as follows:

- Server Machine
- Client Machine
- License Borrowing
Server Machine

There are two parts to the VisualDSP++ Floating License Server:

- VisualDSP++ License Manager
- FLEXnet (formerly called FLEXlm) LMTOOLS

Your floating license serial number is installed through the VisualDSP++ License Manager. A Windows service must then be configured and started using FLEXnet LMTOOLS.

If you are installing the Floating License Server for the first time, go directly to **Task 1B: Installing the VisualDSP++ Floating License Server**.

If you are upgrading an existing installation of the VisualDSP++ Floating License Server, first you must disable and uninstall this existing installation as described in **Task 1A: Disabling and Uninstalling an Existing Floating License Server**, and then install the new version.

Version 2.00.7 and later of the Floating License Server are compatible with VisualDSP++ 4.0, VisualDSP++ 4.5, and VisualDSP++ 5.
Task 1A: Disabling and Uninstalling an Existing Floating License Server

You must perform the following procedure if you are upgrading an existing installation of the VisualDSP++ Floating License Server. The procedure disables and then uninstalls the software.

Uninstalling the Floating License Server tools from Add/Remove programs leaves your license.dat file intact in the \install_path\LMSERVER directory. This means that you can simply re-use your original license.dat file and skip Task 2.

However, to take advantage of the new license borrowing feature introduced in VisualDSP++ 5 and version 2.00.7 of the Floating License Server, you must move your existing license.dat file out of the way and re-install and re-validate your serial numbers. From VisualDSP++ 5 onwards, license strings (and therefore validation codes) have changed in format. This means that you need to re-register all your serial numbers and install the version 5-compatible validation codes sent to you.

For further details, see Registering and Validating Your License.

Save your \install_path\LMSERVER\license.dat file to a safe place before proceeding.

1. From the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> FLEXnet LMTOOLS.

   The LMTOOLS window appears.

2. Click the Start/Stop/Reread tab and click Stop Server.

3. Close LMTOOLS.
4. In the Windows Control Panel, open Add/Remove Programs and uninstall VisualDSP++ Floating License Server (or VisualDSP++ License Manager Server, as it was named in earlier versions).

5. Reboot the machine.

**Task 1B: Installing the VisualDSP++ Floating License Server**

The following one-time procedure installs the VisualDSP++ Floating License Server, consisting of the VisualDSP++ License Manager and FLEXnet LMTOOLS.


2. Navigate to the download target folder, and unzip the VisualDSP_-FLS_xxxx.zip file.

3. Run setup.exe.

The InstallShield wizard appears.
4. Follow the prompts.

The wizard completes the Floating License Server installation. The default installation path is shown in Figure 3-1.

![InstallShield Wizard](image)

Figure 3-1. InstallShield Wizard

A client-license.dat file have been created, ready for installation on your client machine (see Task 4: Installing a Client License).

5. Copy the client-license.dat file from the `<install_path>\LMSERVER` directory to a shared network folder.

Ensure that it has read-only permissions and is accessible to the “Everyone” group.
Task 2: Installing a Server License

If you are upgrading from an earlier release of the Floating License Server and still have your original license.dat located in the \LMSERVER directory, you can skip this task and go directly to Task 3: Configuring and Starting FLEXnet LMTOOLS.

For further details, see Task 1A: Disabling and Uninstalling an Existing Floating License Server.

Perform the following procedure for each floating license serial number. One serial number is installed for each single seat or 5-seat package.

1. From the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager.

   The VisualDSP++ License Manager dialog box appears (Figure 3-2).

   Figure 3-2. VisualDSP++ License Manager

   2. Click New.
3. In **Serial number**, enter the serial number exactly as it appears, including dashes.

4. Click **OK**.

Upon successful installation, a success message appears.

A **license.dat** file has been created and is located in your `<install_path>\LMSERVER` folder.

- If you are using Windows Vista (or later) and have a User Account Control enabled, the **license.dat** file is saved to your **Virtual-Store** directory:
  C:\Users\<user_name>\AppData\Local\VirtualStore\Program Files\Analog Devices\VisualDSP <version_number>\System.


If using Windows 7 or later, refer to **DOC-1190** on the FAQ page at http://ez.analog.com.

The new license is activated for a temporary period only. The newly installed serial number will appear on the **License** page of the **About**
dialog box (Figure 3-3) and will have a status of Not Validated (Expanding in 30 days).

Figure 3-3. License Page Indicating an Installed Serial Number Expiring in 30 Days

In order to make your full floating license permanent, you must validate it. You can obtain the necessary validation code by registering online as described in Registering and Validating Your License.

If you do not validate the license within the temporary license period, your license will cease to function until you validate it.
Task 3: Configuring and Starting FLEXnet LMTOOLS

This section describes how to configure FLEXnet LMTOOLS to run the Floating License Server as a Windows service and how to set up the path information for your license files.

1. From the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> FLEXnet LMTOOLS.

The LMTOOLS window appears.

2. Click the Service/License File tab and click Configuration using services and LMTOOLS ignores license file path environment variables. Refer to Figure 3-4.

![Figure 3-4. LMTOOLS Service/License File Tab](image-url)
3. Click the Config Services tab.

![LMTOOLS Config Services Tab](image)

**Figure 3-5. LMTOOLS Config Services Tab**

4. Set up the options (see Figure 3-5) as follows:

   In **Service Name**, enter the name of the new service you want to create (or select an existing service).

   Add/modify the name and paths to the existing `lmgrd.exe` file and the `license.dat` file. Also, provide a name (`<your_name>.log`) for the log file, which will then be created if it does not already exist.

   By default, FLEXnet LMTOOLS looks for a license file with a `.lic` extension. Files with a `.dat` extension (the extension used by the VisualDSP++ License Manager) are also accepted. Simply change the extension in the **Files of Type** field to **License Files (*.dat)** when browsing for the file.
Installing a Floating License Server

Ensure that both the **Use Services** option and the **Start Server at Power Up** option are selected.

Click **Save Service** to save this service to the existing list.

5. Click the **Start/Stop/Reread** tab (see **Figure 3-6**) and select your newly created service from the list.

![LMTOOLS Start/Stop/Reread Tab](image)

**Figure 3-6. LMTOOLS Start/Stop/Reread Tab**

6. Click **Start Server**.

The following messages appear:

- Server Starting.
- Server Start Successful.

It may take up to a minute for the server to start.
7. Click the Service Status tab (see Figure 3-7), and then click Perform Status Inquiry.

![Figure 3-7. LMTOOLS Server Status Tab, Showing Status](image)

8. Review the server status, which should indicate success.

If there appears to be a problem, review the above procedure, ensuring that you have followed it step-by-step.

If you have followed the procedure and problems persist, review Troubleshooting. If you continue to have problems, contact Support (see Licensing Support), attaching your license.dat and client-license.dat files.

Notes

- An existing service cannot be overwritten. You can remove a service via the Delete Service button located on the Config Services tab.

- Starting/stopping the server, performing a status inquiry, and re-reading a license.dat file may take up to a minute.
Whenever a change is made to the license.dat file, the file must be re-read by FLEXnet LMTOOLS. You perform this action via the Start/Stop/Reread tab.

If you are running multiple versions of FLEXnet (formerly called FLEXlm) for various products, see Troubleshooting.

If your server or client machines are running a firewall, contact Support as described in Licensing Support for advice on how to proceed.

Client Machine

Perform the following procedure to install a client license on a workstation.

Task 4: Installing a Client License

The client-license.dat file must be available on the server, in a shared network folder that is accessible by all users.

1. On each workstation, install VisualDSP++ 5 and install the latest update (if applicable).

If you are upgrading both client and server software, the server software must be upgraded first. Begin at Task 1A: Disabling and Uninstalling an Existing Floating License Server.

2. From the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ <version_number> -> Manage Licenses.

The Licenses page of the About dialog box appears.

3. Click New.

The Install New License dialog box appears.

4. Click Client License.

5. Click the browse (...) button to open a browser, from which to select the client-license.dat file.

-- or --

In License file, type the name of the server and the license file in the form:
\server_machine_name\<path_to_shared_network_folder>\client-license.dat.

You can locate the “server machine name” on the server machine
via the Windows Start menu by choosing Settings -> Control Panel -> System (or System Properties) -> Computer Name -> <full_computer_name>.

6. Click OK.

The client-license.dat file from your server machine will now be copied to your client machine, renamed as license.dat, and saved to the <install_path>\System directory.

![Figure 3-8. Licenses Page Showing Installed License](image)

**If you are using Windows Vista (or later) and have User Account Control enabled, the license.dat file will be saved to your VirtualStore directory instead:**

C:\Users\<user_name>\AppData\Local\VirtualStore\Program Files\Analog Devices\VisualDSP <version_number>\System.


If using Windows 7 or later, refer to DOC-1190 on the FAQ page at [http://ez.analog.com](http://ez.analog.com).
License Borrowing

If a license.dat file already exists on the client machine (in \install\path\System), a message indicates that the current license.dat file will be renamed to license.bak and the client license will be copied to the client machine.

If you are trying to install both a client license and a node-locked license on the same machine, refer to the relevant information in Frequently Asked Questions (FAQs).

License Borrowing

From VisualDSP++ 5 onwards, you can “check out” a floating license from the server for a predetermined length of time.

While a license is actively being borrowed, the server license count is decreased, effectively providing a full, node-locked license with a fixed expiration date.

When the set borrowing time expires, the server automatically returns the license to the available pool, and the borrowed license on your machine expires, disabling use of VisualDSP++.

Licenses can be returned early to the server. This capability requires that you are connected to the network.

To initiate license borrowing, return licenses early, check the status of borrowed licenses or stop borrowing licenses, use the lmborrow utility provided in the Floating License Server install at \install\path\LMSERVER. Further details can be found in the FLEXnet Licensing End User Guide, described in Further Reading.

When borrowing a license, use analogd as the vendor name.
Further Reading

For a more comprehensive overview of FLEXnet licensing, refer to the *FLEXnet Licensing End User Guide*, which is installed along with both VisualDSP++ 5 and Floating License Server software.

In the VisualDSP++ 5.1 install, this document is located in the `<install_path>\VisualDSP <version_number>\Docs\flex` folder.

In the Floating License Server install, it is located in the `<install_path>\LMSERVER` folder.
This chapter explains how to register your license serial number and obtain the validation code required to make your license permanent.

These procedures apply to full licenses and evaluation licenses only. Test drive licenses function for 90 days and then permanently expire. These licenses cannot be validated.

The chapter contains the following sections:

- Required Information
- Registering Your License
- Validating Your License
Required Information

In order to register your license on the Analog Devices Web site, you must have the following information:

- License serial number
- Host ID

License Serial Number

VisualDSP++ license serial numbers are typically of the form:

- **Full license**: ADI-xxx-xxx-xxxxxx-xx
- **Evaluation license**: KIT-xxx-xxx-xxxxxx-xx

where \( x \) represents a digit (0–9).

License serial numbers are issued on license serial cards and mailed to you at the time of purchase.

Refer to [Obtaining a License Serial Number](#) for details about obtaining a license serial number.

Host ID

FLEXnet licensing uses the host ID, an identifier unique to each computer, to lock licenses to a particular machine.

VisualDSP++ takes the default value of the host ID as the volume (or disk) serial number of the C:\ drive. From VisualDSP++ 5 onwards, if you do not have a hard drive on your machine (or have a setup that results in your machine not having a C:\ drive), the MAC address is used. The MAC address is a unique number associated with the computer’s network card.
Registering and Validating Your License

Finding the Host ID for a Node-Locked License

From the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ <version_number> -> Manage Licenses.

The host ID appears in the bottom-right corner of the resulting dialog box (Figure 4-1).

![Figure 4-1. Licenses Page Showing Host ID](image)

Finding the Host ID for a Floating License

From the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager.
Registering Your License

The host ID appears in the bottom-right corner of the resulting dialog box (Figure 4-2).

![Figure 4-2. Licenses Page Showing Host ID](image)

Registering Your License

You must register full license and evaluation license serial numbers online in order to receive a validation code.

ℹ️ If your machine has no Internet access, you can apply for a validation code from a machine with Internet access at the registration page:

Registering and Validating Your License

Registering a Node-Locked License

To register a node-locked license:

1. Click the Windows Start button. Then choose All Programs -> Analog Devices -> VisualDSP++ <version_number> -> Manage Licenses. The Licenses page of the About dialog box appears.

2. From the list of serial numbers, select the serial number of the license that you want to register.

3. Click Register.

Your system’s default browser is launched, and opens the Analog Devices product registration Web page.

4. Fill in the required fields and submit the form.

A validation code will be e-mailed to you shortly.

Registering a Floating License

To register a floating license:

1. Click the Windows Start button. Then choose All Programs -> Analog Devices -> VisualDSP++ <version_number> -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager.

The VisualDSP++ License Manager application opens.

2. Select the ADI-prefixed serial number of the license that you want to register.
3. Click Register.

Your system’s default browser is launched, and opens the Analog Devices product registration Web page.

4. Fill in the required fields and submit the form.

A validation code will be e-mailed to you shortly.
Validating Your License

You must validate your license in order to make it permanent.

From VisualDSP++ 5 onwards, license strings (and therefore validation codes) have changed in format. Consequently, when registering your serial number and host ID, two validation codes will be e-mailed to you. One is valid for VisualDSP++ 4.5 and earlier versions, and the other is valid for VisualDSP++ 5 and later versions.

Ensure that you install the appropriate validation code for the version of VisualDSP++ you are using. If you try to install the wrong version, you will get the following error message (Figure 4-3):

Figure 4-3. Message: Invalid Validation Code
Validating Your License

Validating a Node-Locked License

This procedure assumes that you have received a validation code via e-mail as described in Registering a Node-Locked License.

To validate a node-locked license:

1. Click the Windows Start button. Then choose All Programs -> Analog Devices -> VisualDSP++ <version_number> -> Manage Licenses.

   The About dialog box appears.

2. Click the Licenses tab.

3. Select the KIT- or ADI-prefixed serial number of the license that you want to validate.

4. Click Validate.

   The Enter Validation Code dialog box appears.

5. In Validation code, enter the validation code.

   Tip: Prevent typos by copying-and-pasting the code string.

6. Click OK.

   Upon successfully entering this validation code, a message indicates that a permanent license has been created.
Registering and Validating Your License

Figure 4-4 shows that the node-locked license has been validated.

![VisualDSP++ License Manager Showing a Validated Node-Locked License](image)

Validating a Floating License

This procedure assumes that you have received a validation code via e-mail as described in Registering a Floating License.

To register a floating license:

1. Click the Windows Start button. Then choose All Programs -> Analog Devices -> VisualDSP++ <version_number> -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager.

   The License Manager application opens.

2. Select the ADI-prefixed serial number of the license that you want to register.

3. Click Validate.

   The Enter Validation Code dialog box appears.
Validating Your License

4. In Validation code, enter the validation code.

   **Tip:** Prevent typos by copying-and-pasting the code string.

5. Click OK.

   Upon successfully entering this validation code, a message indicates that a permanent license has been created.

   **Figure 4-5** shows that the floating license has been validated.

   ![VisualDSP++ License Manager Showing a Validated Floating License](image)

   **Figure 4-5.** VisualDSP++ License Manager Showing a Validated Floating License

You must now run the FLEXnet LMTOOLS application and re-read the `license.dat` file from the **Start/Stop/Reread** tab.

To start FLEXnet LMTOOLS, from the Windows **Start** menu, choose **All Programs** -> **Analog Devices** -> **VisualDSP++ Floating License Server** -> **FLEXnet LMTOOLS**.

See **Installing a Floating License Server** for further details.
5 CHECKING THE STATUS OF YOUR LICENSE

This chapter describes each possible status for each type of VisualDSP++ license.

The chapter contains the following topics:

- Viewing a License’s Status
- Node-Locked Licenses
- Client Licenses

Viewing a License’s Status

To view the status of node-locked licenses, from the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP <version_number> -> Manage Licenses.

To view the status of floating licenses, from the Windows Start menu, choose All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager.
Node-Locked Licenses

You will see a screen similar to Figure 5-1.

Figure 5-1. Example: Licenses Page Showing a Validated License

Node-Locked Licenses

Node-locked licenses include:

- Full Licenses
- Evaluation Licenses
- Test Drive Licenses
Full Licenses

Full licenses have serial numbers that are prefixed with `ADI`. Each full license has a status, as described in Table 5-1.

Table 5-1. Full Licenses – Status Information

<table>
<thead>
<tr>
<th>License Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Validated (Expanding in X days)</td>
<td>This is a full license that expires in X (initially 30) days because it has not yet been validated. You must validate this license to enable permanent use of VisualDSP++; otherwise, the license will expire and VisualDSP++ will become inoperable.</td>
</tr>
<tr>
<td>Validated (Permanent)</td>
<td>This is a full license. It has been validated for permanent use of VisualDSP++.</td>
</tr>
<tr>
<td>Not Validated (Expired)</td>
<td>This license has not been validated. The 30-day grace period is over, and VisualDSP++ is inoperable. You must validate the license to enable permanent use of VisualDSP++.</td>
</tr>
</tbody>
</table>

Evaluation Licenses

Evaluation licenses have serial numbers that are prefixed with `KIT`. Each evaluation license has a status, as described in Table 5-2.

Table 5-2. Evaluation Licenses – Status Information

<table>
<thead>
<tr>
<th>License Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo - Full (Expanding in X days)</td>
<td>This is an evaluation license that expires in X (initially 10) days because it has not yet been validated. You must validate this license to enable permanent use of VisualDSP++; otherwise, the license will expire and VisualDSP++ will become inoperable.</td>
</tr>
<tr>
<td>Demo - Full (Expanding in X days)</td>
<td>This is an evaluation license. It has been validated for permanent use of VisualDSP++. The initial 90-day period of full license evaluation will expire in X days. The license will then become restricted.</td>
</tr>
</tbody>
</table>
Test Drive Licenses

Test drive licenses have serial numbers that are prefixed with TST. Each test drive license has a status, as described in Table 5-3.

Table 5-3. Test Drive Licenses – Status Information

<table>
<thead>
<tr>
<th>License Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Drive (Expanding in X days)</td>
<td>This is a test drive license that expires in X (initially 90) days. You may use VisualDSP++ with emulator or simulator debug sessions only. When the 90 days are up, VisualDSP++ will become inoperable.</td>
</tr>
<tr>
<td>Test Drive (Expired)</td>
<td>This test drive license has expired.</td>
</tr>
</tbody>
</table>
Client Licenses

When a client license is installed, its status is USE_SERVER. In addition, the server name appears under Serial Number, and Client appears under Family.

Figure 5-2. Example: Licenses Page Showing a Client License
This chapter provides answers to common licensing problems and includes the following sections:

- Frequently Asked Questions (FAQs)
- Error Messages

For details on how to contact Support, refer to Licensing Support.
Frequently Asked Questions (FAQs)

This section provides answers to:

- General FAQs
- VisualDSP++ Floating License Server-Specific FAQs

General FAQs

Question: *I have lost my serial number. Where can I find it, or how do I get a replacement?*

Answer: Firstly, note that your serial number was printed on the card and mailed to you after your VisualDSP++ purchase.

In addition, you can locate already installed serial numbers in the IDE by going to:

- Start -> All Programs -> Analog Devices -> VisualDSP++ <version_number> -> Manage Licenses
  or
- Start -> All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager if using a floating license.

If you do not have VisualDSP++ installed and licensed, or have lost your license serial card, e-mail support with details of the person and company to whom the serial number was originally registered. For more information, refer to Licensing Support.

Question: *I uninstalled VisualDSP++ due to a problem, and now when I’m trying to reinstall my serial number I receive the message “The serial number has already been used and can be installed only once”. What should I do?*
**Answer:** TST- and KIT- prefixed serial numbers may only be installed once per machine.

If you have had to uninstall VisualDSP++ for any reason, note that uninstalling via Add/Remove programs in the Windows Control Panel leave the `<install_path>\System\license.dat` file intact. Therefore, you can simply copy and paste this file into the `<install_path>\System` folder of your new instance of VisualDSP++. If you deleted all files in the install path after uninstalling, check your recycle bin for the `license.dat` file.

If you cannot find your original `license.dat` file, contact Support with the serial number that you are trying to reinstall. For more information, refer to Licensing Support.

Back up your `license.dat` file to prevent a similar problem.

**Question:** I've received the message “The serial number has already been used and can be installed only once”, but I've never installed this number before. What’s going on?

**Answer:** TST- and KIT- prefixed serial numbers may only be installed once per machine. Possibly, someone else installed the serial number on this machine in the past.

In addition, TST-prefixed serial numbers may not be installed if a KIT-prefixed serial number for the same architecture is already installed (or has ever been installed) on the same machine.

Contact Support with the serial number(s) in question, explaining the situation. For more information, refer to Licensing Support.

**Question:** I've just installed a full license or evaluation license and now I get a message telling me that the license will expire in X days. I thought these were permanent licenses?
Frequently Asked Questions (FAQs)

**Answer:** When permanent licenses are installed, they initially have only a “temporary” status. In order to make them permanent, they must be validated. Refer to Registering and Validating Your License for further details.

**Question:** I have just upgraded VisualDSP++ and the serial number I was using previously is not accepted. Why?

**Answer:** Certain serial numbers have been made obsolete over the years. Contact Support with your current serial number, and you will be issued a replacement. For more information, refer to Licensing Support.

**Question:** I need to transfer my license to a new machine (or, my hard drive crashed and had to be reformatted). How do I register my license against a new host ID?

**Answer:** To register additional computers, install your serial number on the new machine and register it online with the new host ID at the address below. You will then be sent a validation code by e-mail. Installing this validation code will make your license permanent.


If you receive a message about “...attempting to register more than the allowed number of times...”, request a registration history update via e-mail at processor.tools.registration@analog.com

Include the serial number(s) in question.

**Question:** How can I find out my registration history? That is, how do I find out which machines my serial number(s) are registered against?
Answer: To request an up-to-date registration history, send an e-mail with the serial number(s) in question to:
processor.tools.registration@analog.com.

Question: I registered for a test drive license but I have not yet received it. Why?

Answer: If you registered for a test drive license for SHARC or Tiger-SHARC, the serial number will be displayed on the next Web page, after clicking Register.

If you register for a Blackfin test drive license, the serial number will be e-mailed to you.

In the event of a problem, contact Support. For more information, refer to Licensing Support.

Question: I have registered my evaluation license or full license, but have not yet received a validation code via e-mail. Who should I contact?

Answer: This may have occurred because your e-mail address was not entered accurately into the Web form. Contact Support. For more information, refer to Licensing Support.

Question: I’ve just upgraded to VisualDSP++ 5 and my existing validation code isn’t accepted, even though I’m using the same machine that I registered with. Why is this?

Answer: From VisualDSP++ 5 onwards, license strings (and therefore validation codes) have changed in format. This means that you cannot install a validation code created for an earlier version of VisualDSP++ in version 5 environment.
In order to receive a 5-compatible validation code, re-register your serial number and host ID. You will then be e-mailed with two validation codes. One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid for VisualDSP++ 5 and later versions. Ensure that you install the appropriate version.

For more information, refer to Registering and Validating Your License.

**Question:** The validation code that was e-mailed to me is being rejected. What could be the problem?

**Answer:** Firstly, note that validation codes are valid for a particular serial number and host ID combination. Therefore, if you are trying to install your serial number on a second machine, you will have to register it with the new host ID in order to receive the appropriate validation code.

Also, from VisualDSP++ 5 onwards, license strings, and therefore validation codes, have changed in format. This means that when you register your serial number and host ID, you will be e-mailed with two validation codes. One is valid for VisualDSP++ 4.5 and earlier versions, and the other is valid for VisualDSP++ 5 and later versions. Ensure that you install the appropriate version.

For more information, refer to Registering and Validating Your License.

**Question:** I have been using a test drive license for 36 days and have now bought an EZ-KIT Lite. My simulator debug session still works but I cannot connect to the EZ-KIT Lite debug session. Why not?

**Answer:** EZ-KIT Lite debug sessions are not supported by test drive licenses (serial numbers prefixed with TST). You must install and register the evaluation license serial number (prefixed with KIT), which can be found on a sticker affixed to the back of the CD sleeve that came with your EZ-KIT Lite.
Question: I have an evaluation license and was working with an emulator/simulator debug session until today, when I started receiving error messages. Why can’t I connect to my emulator/simulator debug session any more?

Answer: An EZ-KIT Lite license incorporates an initial 90-day full license. Once the 90 days have passed, the evaluation license becomes restricted, prohibiting simulator and emulator debug sessions and restricting the amount of internal memory that is available for code (program memory). Refer to Licensing Overview for further details.

Question: I’m getting errors when trying to use VisualDSP++ with Remote Desktop. What could be the problem?

Answer: VisualDSP++ did not support connection through Remote Desktop before VisualDSP++ 5 and, in fact, actively disallowed it with node-locked licenses prior to this release.

If you are using VisualDSP++ 4.5 or earlier, try using a single-session remote access application, such as VNC. However, note that we offer no support for this.

If you are using VisualDSP++ 5, you may still be unable to use remote desktop if you used the advanced option to copy over your license.dat file from an earlier version of tools during installation of the latest tools. If your license.dat was copied from an earlier release of the tools, we recommend that you rename your current license.dat file, which can be found in the System folder of your VisualDSP++ 5 installation, to license_old. Then you will need to reinstall your license number and obtain a new, VisualDSP++ 5 compatible, validation code.
Question: I’m running VisualDSP++ on Windows Vista (or Windows 7) and having some problems with my license. I can’t find the license.dat file my colleague installed. What’s going on?

Answer: With the release of Windows Vista, Microsoft has introduced a new security feature called User Account Control (UAC). UAC is a framework that, when enabled, provides a more secure operating environment for the user, which prohibits modification of critical system directories and files. One of these directories is the Program Files directory into which VisualDSP++ is installed when selecting the default setup options.

Licenses in VisualDSP++ are stored in a file called license.dat located within the System directory of your VisualDSP++ installation folder. When installing a new license with UAC enabled, changes to the license.dat file will be redirected to the current user’s VirtualStore directory. Because VirtualStore directories are specific to each user, this has the added side effect that other users on the machine will not have access to these licenses when using VisualDSP++.

To solve this, manually copy the license.dat file from the first user’s VirtualStore directory into the <install_path>\System directory. The VirtualStore is located in:

C:\Users\<user_name>\AppData\Local\VirtualStore\Program Files\Analog Devices\VisualDSP \{x.y\}System.

where <user_name> is the name of the user who originally installed the license, and x.y is the version of VisualDSP++ into which the license was installed.

If using Windows 7 or later, refer to *DOC-1190* on the FAQ page at http://ez.analog.com.
**Frequently Asked Questions (FAQs)**

**VisualDSP++ Floating License Server-Specific FAQs**

**Question:** The LMTOOLS are asking for a *.lic file, but can’t find one. Why not? I’ve already installed my serial number.

**Answer:** The LMTOOLS application accepts license files with both the .lic and .dat extension. By default, when browsing for a license file, LMTOOLS looks for files with a .lic extension. Simply change the Files of type field to the .dat extension and you should find your license.dat file.

**Question:** How do I check whether my FLEXnet service is running?

**Answer:** This can be checked by starting the FLEXnet LMTOOLS and clicking Perform Status Enquiry on the Server Status tab.

You can also check in the following way. Note the service name in the Service Name field of the Config Services tab. Then go to Administrative Tools in the Windows Control Panel and start the Services program. In the list of services in the right-hand panel, check that the status of your service is Started. If it is not, go to the Start/Stop/Reread tab in LMTOOLS and click the Stop Server button and then click the Start Server button.

If this also fails, locate the debug log file indicated on the Config Services tab of LMTOOLS and send it to Support. For more information, refer to Licensing Support.

**Question:** How do I use FLEXnet Licensing with more than one product? Can I combine license.dat files?

**Answer:** Yes, FLEXnet can manage licensing for multiple products, and there are several ways to achieve this. Full details on using FLEXnet licensing with more than one product is outside the scope of this document;
refer to the section entitled “Managing Licenses from Multiple Vendors” in the *FLEXnet Licensing End User’s Guide*.

Should you require further assistance, contact Macrovision.

However, one method that has shown to be successful is to run the FLEXnet server on one machine, running only one license server system. In this case, ensure that each service run by LMTOOLS (including those for products other than VisualDSP++) uses the *same* version of the \texttt{lmgrd.exe}, and that \texttt{lmgrd.exe} is the latest version installed.

This can be done by renaming the existing \texttt{lmgrd.exe} in each vendor’s FLEXnet (formerly named FLEXlm) folder, to move it out of the way, and then copying in the latest version available to replace it. Alternatively, you can change the Path to the \texttt{lmgrd.exe} field on the Config Services tab in LMTOOLS for each service, so that it points to the most up-to-date \texttt{lmgrd.exe} file.

**Question:** How do I move my Floating License Server to a new machine?

**Answer:** Set up your new license server(s) and reinstall your client licenses to point to this new server (as outlined in Installing a Floating License Server). Re-register each serial number with the host ID of the new server (Registering and Validating Your License). Once you have done this, e-mail processor.tools.registration@analog.com, requesting that the old machine(s) be removed from your registration history. Be sure to include all relevant serial numbers and host IDs. A registration history will be provided upon request.

Once your new server is up and running, disable the old server.

**Question:** I’ve upgraded to VisualDSP++ 5 and also need to upgrade my Server License software. Will I still be able to use older versions of VisualDSP++ with the new version of the server software?
**Frequently Asked Questions (FAQs)**

**Answer:** The Floating License Server is compatible with all VisualDSP++ versions greater than and including VisualDSP++ 4.0.

If anyone on your network is working with the ADSP-218x or ADSP-219x architectures and therefore needs to run VisualDSP++ 3.5 for 16-bit Processors, refer to the following question/answer, or contact Support for assistance. For more information, refer to Licensing Support.

**Question:** You state that the latest version of the Floating License Server tools are not compatible with VisualDSP++ 3.5. However, I need to use VisualDSP++ 3.5 for 21xx on the same network as I'm using VisualDSP++ 5. Is there a way around this?

**Answer:** There are a number of ways to do this; one example is given below. If this does not cover your particular circumstance, contact Support. For more information, refer to Licensing Support.

**Example:** If you have an existing installation of VisualDSP++ 3.5 that uses floating licenses, do the following:

1. Save the existing `license.dat` file on your server to a safe place, as a precaution.

2. Disable and uninstall your license server tools.

   Note that uninstalling the Floating License Server tools (formerly known as the License Server Manager) from Add/Remove programs leaves the install path, and your `license.dat` file, intact in the `C:\Program Files\Analog Devices\VisualDSP\LMSERVER` directory. This means that you can re-use your original `license.dat` file.

3. In your `license.dat` file, comment out any license strings for any architectures other than 21xx. This can be done by placing a “#” at the start of each line; for example:
# FEATURE FRIO-FULL analogd 1.0 3-aug-2007 5 DDDDEEEFFFF \ # VENDOR_STRING=ADI-111-11111-111111-10

# INCREMENT FRIO-FULL analogd 1.0 permanent 5 AAAABBBBCCCC\ # VENDOR_STRING=ADI-111-11111-111111-10

**Note:** License strings can be found after the line:

# Begin FEATURE definitions”.

4. Install the latest version of the Floating License Server (currently version 5.0.1.x). Since your original license.dat file should still be in the C:\Program Files\Analog Devices\VisualDSP\LMSERVER directory, the new tools should detect it, and any further serial numbers installed through the VisualDSP++ License Manager will be appended to it.

5. Re-install any SHARC, TigerSHARC, or Blackfin serial numbers you wish to use. Be sure to register and validate them within 30 days.

6. Use FLEXnet LMTOOLS to configure and run the License Server.

See **Installing a Floating License Server** for further details of how to perform the above procedure. If you have problems with the above procedure or have any questions, contact Support.

**Question:** *I have to add additional licenses to the License Server. How do I do this?*

**Answer:** The license server must be stopped first via the FLEXnet LMTOOLS STOP/START/READ utility in the **Configure Services** window. Then follow the procedure as outlined in **Task 2: Installing a Server License**. You must then restart the server.
Question: How do I install both a node-locked license and floating license on the same machine?

Answer: Follow this procedure.

1. Install and validate (if necessary) your node-locked license on your client machine. Follow the procedure outlined in Installing a Node-Locked License.

2. Install and validate your floating license on your server machine. Follow the procedure outlined in Installing a Floating License Server.

3. Copy the “# Begin FEATURE” section along with the node-locked license string from <install_path>\System\license.dat on the client machine to the end of the “# Begin FEATURE” section of the \VisualDSP\LMSERVER\license.dat file on your server machine.

4. Install the client license.dat file part of your floating license on the client machine by following the procedure outlined in Installing a Floating License Server. This will replace your node-locked license.dat file with one that simply points to the server. The existing license.dat file will be renamed to license.bak so that the information contained in it is preserved.

Note: Users on other client machines may receive an error message regarding the node-locked license, should all floating licenses be in use at the time they try to check one out.

For further information, refer to Q&A article QA0000555 in the Processors and DSP Knowledge Base on the Analog Devices Web site at http://www.analog.com/processors/knowledgebase.
Question: I’m having trouble getting my floating license to work. My server machine and/or my client machine has a firewall running. Could this be the problem?

Answer: Yes. You may need to make some changes to your floating license setup in order to workaround this. Contact Support for further information.

Question: I’m installing a floating license and Corporate IS policies prohibit shared network folders on my server machine. Are there any alternatives to installing client licenses?

Answer: Yes. An alternative method of installing a client license, which doesn’t require the creation of a shared network folder or use of the VisualDSP++ GUI, is to simply copy the `<server_install_path>\LMSERVER\client-license.dat` file to each client machine’s `<install_path>\System` folder, and rename it to `license.dat`.

**Error Messages**

This section describes:

- General Error Messages
- VisualDSP++ Floating License Server-Specific Errors
- Warning Messages

**General Error Messages**

General error messages include:

- Errors Issued in Message Boxes
- Errors Issued in the Output Window or on the Command Line
Errors Issued in Message Boxes

**Problem:** The serial number has already been used and can be installed only once.

**Solution:** The serial number you are trying to install has already been installed on this machine. Note that evaluation and test drive serial numbers may only be installed once per machine. In addition, test drive serial numbers may not be installed if an evaluation license for the same architecture has already been installed on that machine. For further information, refer to Licensing Overview.

**Problem:** The serial number already exists. You will need to register the serial number to receive a validation code. If you already have a validation code, select the serial number and click the Validate button.

**Solution:** VisualDSP++ found the serial number you entered; it is already in the licence.dat file. If you have already installed that serial number but have not yet registered it and received a validation code, follow the steps outlined in Registering and Validating Your License.

**Problem:** The serial number you entered is invalid. Please re-enter the number, ensuring that you type the number EXACTLY as shown on the registration card.

**Solution:** Ensure that you have typed in the correct serial number, exactly as given. If you continue to have problems, contact Support, sending your serial number and <install_path>\System\license.dat file, if available. For more information, refer to Licensing Support.
**Problem:** The serial number you have entered is no longer valid. Please contact Support (dsptools.support@analog.com or 1-800-analogd) to update your serial number.

**Solution:** VisualDSP++ has detected that the serial number you are trying to install is no longer valid. Certain serial numbers have been made obsolete over the years. Contact Support with your current serial number, and you will be issued with a replacement. For more information, refer to Licensing Support.

**Problem:** VisualDSP++ has detected an invalid serial number. Please verify the serial number is accurate with the one received with the VisualDSP++ product. If the problem persists, please contact Analog Devices' technical support at http://www.analog.com/support.

**Solution:** VisualDSP++ detected an invalid serial number in your license.dat file. This error can occur when your license.dat file contains a once-valid serial number that has been made obsolete in later versions of VisualDSP++. In this case, contact Support with your current serial number and you will be issued a replacement serial number. For more information, refer to Licensing Support.

**Problem:** The serial number you entered is a Server serial number. Please run the server license installation program to use this serial number.

**Solution:** The serial number you are trying to install is a floating license serial number. This must be installed through the separate Floating License Server application, rather than through the VisualDSP++ IDDE. Refer to Installing a Floating License Server for further details.
Problem: The validation code that you entered is invalid. Please re-enter the code, ensuring that you type the code EXACTLY as you received it. It might be helpful to copy-and-paste your validation code rather than typing it manually.

Solution: VisualDSP++ detected that you entered an invalid serial number. Ensure that you have entered the correct validation code, exactly as given.

Validation codes are valid for a particular combination of serial number and host ID. If you are trying to install your serial number on a different machine than the one you initially registered, you will need a new validation code. Refer to Registering and Validating Your License for further details.

From VisualDSP++ 5 onwards, license strings (and therefore validation codes) have changed in format. Consequently, when registering your serial number and host ID, two validation codes will be e-mailed to you. One is valid for VisualDSP++ 4.5 and earlier versions; the is valid for VisualDSP++ 5 and later versions. Ensure that you install the appropriate validation code for the version of VisualDSP++ you are using.

If you continue to have problems, e-mail processor.tools.registration@analog.com, identifying your serial number, validation code, and host ID.

Problem: The file does not contain valid client license information.

Solution: VisualDSP++ detected an invalid client license file. Ensure that you select the correct client-license.dat file.

Problem: The filename as entered could not be found. Ensure that the path is correct and the file exists.
Solution: VisualDSP++ detected that an invalid path or file name has been entered for the location of the client-license.dat file. Ensure that the path is correct and the file exists.

Problem: Error: Cannot find a valid license path

Solution: VisualDSP++ was not able to find the given path to the license.dat file. This indicates that the registry setting that stores the location of your license.dat file is incorrect, missing, or has been corrupted. Try uninstalling, rebooting, and reinstalling VisualDSP++.

If the problem persists, contact Support for further assistance. For more information, refer to Licensing Support.

Problem: Failed to delete the license file: C:\Program Files\Analog Devices\VisualDSP++ <version_number>\System\license.dat

-- or --

Failed to copy the license file to: C:\Program Files\Analog Devices\VisualDSP++ <version_number>\System\license.client_backup

-- or --

Failed to open the license file: C:\Program Files\Analog Devices\VisualDSP++ <version_number>\System\license.dat

-- or --

Failed to copy the license file to C:\Program Files\Analog Devices\VisualDSP++ <version_number>\System
**Solution:** VisualDSP++ had a problem accessing the `license.dat` file located in the `<install_path>\System` folder. This can be caused by the `System` folder, parent folders, or the `license.dat` file itself having read-only permission, by the file currently being held open by another application, or by another disk/file access problem. Verify that the file and folders have the proper settings to enable copying files and try again.

If the problem persists, contact Support for further assistance. For more information, refer to Licensing Support.

**Problem:** Invalid license file. The license file may either be damaged or missing. Please confirm that the following file exists:

C:\Program Files\Analog Devices\VisualDSP++<version_number>\System\license.dat

**Solution:** VisualDSP++ had a problem accessing the `license.dat` file located in the `<install_path>\System` folder. This can be caused by the `System` folder, parent folders, or the `license.dat` file itself having read-only permission, by the file currently being held open by another application, or by another disk/file access problem. Verify that the file and folders have the proper settings to enable copying files and try again.

This can also be caused by a `license.dat` file that includes invalid information.

If the problem persists, contract Support for assistance. For more information, refer to Licensing Support.

**Problem:** Error: Failed to get a valid host id

**Solution:** VisualDSP++ was not able to get a valid host ID from your computer, which is a modified version of the volume serial number. From the C:\ drive, try running the “vol” command from the command prompt to verify that you have a physical hard drive with a volume serial number.
If you do not have a hard drive (or if your setup results in you having no C:\ drive), run `ipconfig/all` from the command prompt to verify that you have a MAC address (the physical address of the network card). If you have a volume serial number or a MAC address, try uninstalling, rebooting, and reinstalling VisualDSP++ to see whether that fixes the problem.

If the problem persists, contact Support for further assistance. For more information, refer to Licensing Support.

**Errors Issued in the Output Window or on the Command Line**

**Problem:** *Error code: 0x80040112*  
*Error description: Target not licensed for use*

**Solution:** This error is issued when trying to connect to a debug session. VisualDSP++ was not able to find a license for the specific processor type with which you are currently working.

This means that your license is not installed correctly or that you are attempting to run a debug session for which you are not licensed. Examples of the latter problem include attempting to run a SHARC debug session when you only have a Blackfin license installed, or attempting to run an EZ-KIT Lite debug session when you only have a test drive license installed. For more information, refer to Licensing Overview.

**Problem:** *Error: cc1458: Fatal Error: could not obtain license*

**Solution:** This error is caused by the compiler. The compiler could not find a `license.dat` file. Ensure that your license is correctly installed and that it is for the same architecture as the target processor of the project you are trying to build. Contact Support if you require further assistance. For more information, refer to Licensing Support.
**Problem:** [Error: ea1156]  
Failed to get a license to run the assembler

**Solution:** This error is issued by the assembler. The assembler could not find a valid license.dat file. Ensure that your license is correctly installed and that it is for the same architecture as the target processor of the project you are trying to build. Contact Support if you require further assistance. For more information, refer to Licensing Support.

**Problem:** Error li1143  
Failed to obtain license

**Solution:** This error is issued by the linker. The linker could not find a valid license.dat file. Ensure that your license is correctly installed and that it is for the same architecture as the target processor of the project you are trying to build. Contact Support if you require further assistance. For more information, refer to Licensing Support.

**Problem:** Error li1042  
22742 (more than 22K) are used by code, while only 20KB are allowed under EZ-KIT Lite license restriction

**Solution:** This error is caused by the linker. Evaluation licenses restrict the amount of internal program memory that is available to the processor. The exact amount that is available varies with each EZ-KIT Lite. If you want to increase the available memory, upgrade to a full license. For further information, refer to the EZ-KIT Lite manual.
Troubleshooting

VisualDSP++ Floating License Server-Specific Errors

VisualDSP++ Floating License Server-Specific errors include:

- Errors Issued in Message Boxes
- Errors Issued by FLEXnet Tools

Errors Issued in Message Boxes

Problem: The license manager has detected that a server license is being used and that there is a problem communicating with the license server software. This could be due to an out-of-date version of the license server software or there is not a network connection with the license server. Please check your connection to the network or if your the server software is out-of-date update the server tools using the latest license server installation. The license server installer can be downloaded from http://www.analog.com/enprocessors-dsp/software-and-reference-designs/content/visualdsp_tools_upgrades/fca.html.

Solution: VisualDSP++ has detected a problem while communicating with the VisualDSP++ Floating License Server. This error is usually followed by a second error, headed “Flexible License Manager”, which gives specific FLEXnet error codes, and which may help you narrow down the problem when referring to the FLEXnet Licensing End User's Guide.

Likely causes include:

- A problem with your connection to the network
- The instructions outlined in Installing a Floating License Server have not been followed correctly
- The version of the License Server Manager you are using is not a recent enough version for the version of VisualDSP++ that you are using. For VisualDSP++ 5, version 2.00.7 or later must be installed.
• The FLEXnet service is not running

For details on how to check this, refer to the FAQ entitled “How do I check whether my FLEXnet service is running?”

• A firewall is running on one or both machines. If so, contact Support for information on working with FLEXnet licensing with firewalls. For more information, refer to Licensing Support.

• More than one application that uses the FLEXnet (previously known as FLEXlm) License Tools is running on the network.

If this is the case, review the FLEXnet Licensing End User’s Guide, which has a section entitled “Managing Licenses from Multiple Vendors”. Note that for most setups, only one version of lmgrd.exe should be run on any network, and that version must be the latest one installed. See also the FAQ entitled “How do I use FLEXnet Licensing with more than one product?”.

Problem: The serial number already exists.

Solution: The VisualDSP++ License Manager has detected that the serial number you are trying to install already exists in your license.dat file.

Problem: The serial number entered is not a server serial number. Please enter a serial number that was created for the server.

Solution: The VisualDSP++ License Manager has detected that the serial number you are trying to install is a node-locked license serial number. The Floating License Server is not required for use with this type of license.

Install your node-locked license through the VisualDSP++ IDDE. Refer to Installing a Node-Locked License for further details.
Problem: The serial number you entered is invalid. Please re-enter the number, ensuring that you type the number EXACTLY as shown on the registration card.

Solution: Ensure that you have typed in the correct serial number, exactly as given. If you continue to have problems, contact Support, sending your serial number and `<install_path>\System\license.dat` file, if available. For more information, see Licensing Support.

Problem: The serial number you have entered is no longer valid. Please contact Support (dsptools.support@analog.com or 1-800-analogd) to update your serial number.

Solution: The VisualDSP++ License Manager has detected that the serial number you are trying to install is no longer valid. Certain serial numbers have been made obsolete over the years. Contact Support with your current serial number, and you will be issued with a replacement. For more information, see Licensing Support.

Problem: The validation code that you entered is invalid. Please re-enter the code, ensuring that you type the code EXACTLY as you received it. It might be helpful to copy-and-paste your validation code rather than typing it manually.

Solution: The VisualDSP++ License Manager has detected that you entered an invalid validation code. Enter your validation code exactly as given.

Validation codes are valid for a particular serial number and host ID combination. If you are trying to install your serial number on a different machine than the one you initially registered, you will require a new validation code. Refer to Registering and Validating Your License for further details.
From VisualDSP++ 5 onwards, license strings (and therefore validation codes), have changed in format. Consequently, when registering your serial number and host ID, two validation codes will be e-mailed to you. One is valid for VisualDSP++ 4.5 and earlier versions; the other is valid for VisualDSP++ 5 and later versions. Ensure that you install the appropriate validation code for the version of VisualDSP++ you are using.

If you continue to have problems, e-mail processor.tools.registration@analog.com, identifying your serial number, validation code, and host ID.

**Problem:** Invalid license file. The license file may either be damaged or missing. Please confirm that the following file exists: C:\Program Files\Analog Devices\VisualDSP\LMSERVER\license.dat

**Solution:** The VisualDSP++ License Manager had a problem accessing the license.dat file located in the <install_path>\LMSERVER folder. This can be caused by the LMSERVER folder or the license.dat file itself having “read only” permission, by the file currently being opened by another application, or by another disk/file access problem. Verify that the file and disk drive have the proper settings to enable copying files and try again.

This can also be caused by the license.dat file including invalid information.

If the problem persists, contact Support for further assistance. For more information, see Licensing Support.

**Problem:** Failed to copy the license file to license.bak

**Solution:** The VisualDSP++ License Manager was not able to create the backup license file <install_path>\LMSERVER\license.bak. This can be the result of a read/write permission issue on the LMSERVER folder in the VisualDSP++ install directory, a lack of disk space, the file attributes on
<install_path>\LMSERVER\license.dat being set to hidden, or another disk/file access problem. Verify that the file and disk drive have the proper settings to enable copying files and try again.

If the problem persists, contact Support for further assistance. For more information, see Licensing Support.

**Problem:** *Error: Failed to get a valid host id*

**Solution:** The VisualDSP++ License Manager was not able to get a valid host ID, which is a modified version of the volume serial number, from your computer. From the C:\ drive, try running the “vol” command from the command prompt to verify that you have a physical hard drive with a volume serial number. If you do not have a hard drive (or if your setup results in you having no C:\ drive), run `ipconfig/all` from the command prompt to verify that you have a MAC address (the physical address of the network card). If you have a volume serial number or a MAC address, try uninstalling, rebooting, and reinstalling VisualDSP++ to see whether that fixes the problem.

If the problem persists, contact Support for further assistance. For more information, refer to Licensing Support.

**Problem:** *The application failed to initialize properly OR Can't find DLL MSVCP80.DLL*

**Solution:** These errors can be an indication that the Microsoft Visual C++ 2005 SP1 Redistributable package has not been installed as part of the Floating License Server as it should be.

The package can be downloaded from:
Errors Issued by FLEXnet Tools

Figure 6-1. Example: FLEXnet Tools Error Message

For information on resolving errors issued directly by the FLEXnet licensing tools (Figure 6-1), refer to the *FLEXnet Licensing End User Guide*, which is installed with both VisualDSP++ 5 and Floating License Server software.

In the VisualDSP++ 5 installation, this document is located in the `<install_path>\Docs\flex` folder.

In the Floating License Server installation, this document is located in the `<install_path>\LMSERVER` folder.
Warning Messages

Warning messages include:

- **Warnings that Display in Message Boxes**
- **Warnings that Display in the Output Window or on a Command Line**

**Warnings that Display in Message Boxes**

**Problem:** The following serial number will expire in x days.
ADI-152-256-999999999-0000

-- or --

The following serial number expires today.
ADI-152-256-999999999-0000

**Solution:** The given serial number has not yet been validated and will expire in x days (or today). Refer to Registering and Validating Your License for further details.

**Problem:** C:\Program Files\Analog Devices\VisualDSP++ <version_number>\System\license.dat already exists.
The file will be renamed to license.bak and the new file will be added.

**Solution:** The warning is issued when an existing license.dat file has been detected and is being replaced. This happens whenever you validate an existing license or add a new license.
Error Messages

Warnings that Display in the Output Window or on a Command Line

**Problem:** [Informational ea1154] License to use this tool will expire in x days

**Solution:** The assembler has detected that your license will expire in x days. If you have an evaluation license or a full license, register and validate it.
A LICENSING SUPPORT

If you are still experiencing a problem after having tried to solve it using the information in this guide, you can contact Analog Devices Customer Support for assistance.

The chapter contains the following sections:

- Information Required by Support
- E-Mail Support
- Telephone Support

Information Required by Support

When contacting Support regarding a licensing issue, please send the following information if e-mailing (or have it available if telephoning):

- Version of VisualDSP++ and update (if any)
- License serial number(s) in question
- `<install_path>\System\license.dat` file (if available)
- Screen captures of encountered error messages
Floating Licenses

If you are using a floating license, also provide the following information:

- **Version of the Floating License Server**
  This is displayed in the title bar of the Start -> All Programs -> Analog Devices -> VisualDSP++ Floating License Server -> VisualDSP++ License Manager dialog box.

- `<server_install_path>\<your_name>\license.dat` file

- `<server_install_path>\<your_name>\*.log` file

- Screenshots of encountered error messages

**E-Mail Support**

You can obtain support via e-mail as follows.

**Registration Support:**

Contact Registration Support if you have any problems with registering or validating your license serial number, or if you have lost your license serial number. Use the following e-mail address:

processor.tools.registration@analog.com.

**Processor Tools Support:**

For all other queries regarding VisualDSP++ licensing, contact Processor Tools Support. Use the following e-mail address:

processor.tools.support@analog.com.

**Telephone Support**

In the USA only, licensing inquiries can be made to the following toll-free phone number: 1-800-ANALOGD (800-262-5643)
I  INDEX

Numerics
5-seat bundle licenses, 1-9

A
About dialog box, 2-1
Licenses page, 2-4
ADI serial numbers, 1-6

B
borrowing licenses, 3-16

C
checking license status, 5-1
client
floating licenses, 3-1
licenses installing, 3-13
machine, 3-13
client-server licenses, 1-9
configuring
FLEXnet LMTOOLS, 3-9

D
demo licenses, 1-8
dialog boxes
About, 2-1

E
error messages
licensing, 6-15
evaluation licenses, 1-8
obtaining serial number, 1-10
EZ-KIT Lite licenses, 1-8

F
FAQs
licensing, 6-2
FLEXnet/FLEXnet
LMTOOLS, 3-2
FLEXnet licensing
documentation, 3-17
FLEXnet LMTOOLS, 3-2, 3-4, 4-10
configuring and starting, 3-9
floating licenses, 1-9
finding host ID, 4-3
installing, 3-6
registering, 4-5
setting up, 3-1
validating, 4-9
Floating License Server
VisualDSP++, 3-2
Floating License Server Installer, 3-4
frequently asked questions
licensing, 6-2
full licenses
about, 1-7
obtaining serial number, 1-10
Index

H
host ID, 4-2
  finding for floating licenses, 4-3
  finding for node-locked licenses, 4-3

I
installing
  client licenses, 3-13
  node-locked licenses, 2-1
  server licenses, 3-6
  VisualDSP++ License Manager for first time, 3-4

K
KIT serial numbers, 1-6

L
license.dat files
  about, 1-5
  valid license not found message, 2-2
license files, installing path information, 3-9
License Manager
  VisualDSP++, 3-2
license registration
  required information, 4-2
licenses
  5-seat bundles, 1-9
  locating installed serial numbers, 1-11
  obtaining serial numbers, 1-10
  serial numbers, 1-6
  single-seat, 1-9
  status, checking, 5-1
  validating, 4-7
licenses, borrowing, 3-16
 license strings, 1-5
licensing
  e-mail support, A-2
  error messages, 6-15
  frequently asked questions, 6-2
  options, 1-6
  problems, 6-1
  support, A-1
  telephone support, A-2
  troubleshooting, 6-1
  warning messages, 6-29
LMTOOLS
  service, 3-9

M
MAC address
  as host ID, 4-2

N
node-locked licenses, 1-7, 4-3
  installing, 2-1
  registering, 4-5
  validating, 4-8

P
permanent licenses, 1-7
per user licenses, 1-7

R
registering
  floating licenses, 4-5
  license serial numbers, 4-1
  node-locked licenses, 4-5
Index

S
serial numbers
  entering, 2-3
license types, 1-6
locating already installed, 1-11
obtaining for licenses, 1-10
registering, 4-1
server
  starting, 3-11
server licenses
  installing, 3-6
server machine
  floating licenses, 3-1
  name, 3-14
single-seat licenses, 1-9
single-user licenses, 1-7
starting
  FLEXnet LMTOOLS, 3-9
status
  license check, 5-1
Support
  licensing, A-1
support
  licensing, A-1

T
technical support, -xi
test drive licenses, 1-8
  obtaining serial number, 1-10
troubleshooting
  licensing, 6-1
TST serial numbers, 1-6

U
UAC, 6-8

unrestricted licenses, 1-7
upgrading
  existing VisualDSP++ Floating License Server, 3-3
  to VisualDSP++ 5, 1-5
upgrading to a new release, 1-3
User Account Control, 2-4, 3-7, 3-15, 6-8

V
validating
  floating licenses, 4-9
  licenses, 4-7
  node-locked license, 4-8
validation codes, 1-5
  changes to, 1-5
  obtaining, 4-1
VirtualStore directories, 6-8
VisualDSP++
  Floating License Server, 3-2
  Floating License Server Installer, 3-4
  license.dat files, 1-5
  License Manager, 3-2
  locating already installed serial numbers, 1-11
  upgrading, 1-3
  upgrading from earlier versions, 1-5
VisualDSP++ Floating License Server
  error messages, 6-23
  FAQs, 6-10
  upgrading, 3-3
VisualDSP++ License Manager
  installing the first time, 3-4

W
warning messages
  licensing, 6-29

VisualDSP++ 5 Licensing Guide I-3